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U.S. DEPARTMENT OF TRANSPORTATION 
FEDERAL AVIATION ADMINISTRATION 

National Policy 
ORDER 

8000.82A 

 Effective Date: 
7/6/23 

SUBJ: Amended Designation of Aviation Safety Action Program (ASAP) Information 
As Protected From Public Disclosure Under 14 CFR Part 193 

1. Purpose of This Order. This order amends and expands the prior designation of information 
received by the Federal Aviation Administration (FAA) from an Aviation Safety Action Program 
(ASAP) as protected from public disclosure in accordance with the provisions of Title 14 of the 
Code of Federal Regulations (14 CFR) part 193. 

2. Audience. This order applies to all FAA employees who receive or review information from 
an ASAP. 

3. Where You Can Find This Order. You can find this order on the MyFAA employee 
website at https://employees.faa.gov/tools_resources/orders_notices and the Dynamic Regulatory 
System (DRS) at https://drs.faa.gov. Operators and the public can find this order on the FAA’s 
website at https://www.faa.gov/regulations_policies/orders_notices and DRS. 

4. What This Order Cancels. FAA Order 8000.82, Designation of Aviation Safety Action 
Program (ASAP) Information As Protected From Public Disclosure Under 14 CFR Part 193, 
dated September 3, 2003, is canceled. 

5. Background. Under Title 49 of the United States Code (49 U.S.C.) § 40123, certain 
voluntarily provided safety and security information is protected from disclosure to encourage 
persons to provide the information to the FAA. The FAA must first issue an order making certain 
findings before the information is protected from disclosure. Part 193 describes the notice 
procedure for the FAA to designate information as protected. If the Administrator issues an order 
designating information as protected under 49 U.S.C. § 40123, that information will be exempt 
from public disclosure under the Freedom of Information Act (FOIA) Exemption 3. Such 
information will not be disclosed under FOIA, or other laws except as provided in 49 U.S.C. 
§ 40123, part 193, and the order designating the information as protected. 

6. Applicability. This order is applicable to any FAA office that receives information covered 
under this designation from an ASAP program. The order also is applicable to any other 
government agency with safety and security responsibilities that receives such information from 
the FAA. In order for any other government agency to receive information submitted in an 
ASAP report (i.e., ASAP information) covered under this amended designation from the FAA, 
each such agency must first stipulate, in writing, that it will abide by the provisions of part 193 
and this order. Such information will not be disclosed under FOIA, or other laws except as 
provided in 49 U.S.C. § 40123, part 193, and the order designating the information as protected. 
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7. Summary of the ASAP Voluntary Information Sharing Program. 

a. Who May Participate? Under Advisory Circular (AC) 120-66C, Aviation Safety Action 
Program, air carriers, repair stations, and other entities (collectively referred to as “eligible 
entities”) who have an FAA-approved ASAP, and their covered employees, may participate in 
ASAP. The amended designation (i.e., Order 8000.82A) covers the expansion of ASAP to such 
eligible entities. In contrast, the prior AC 120-66B and the original designation (i.e., 
Order 8000.82) were only intended to apply to air carriers that operated under 14 CFR part 121 
and for domestic repair stations certificated under 14 CFR part 145 that have an FAA-accepted 
ASAP, and their covered employees. 

b. What Voluntarily Provided Information Will Be Protected From Disclosure Under 
This Amended Designation? The type of information to be protected in Order 8000.82A (as 
amended) remains the same as in Order 8000.82. The following information will be protected 
from disclosure when provided in a report to the FAA that meets the acceptance criteria under 
the ASAP program: 

(1) The employee’s ASAP report, and the content of that report. 

(2) The identity of the eligible entity associated with an accepted ASAP report. 

(3) The name of the employee who submits an accepted ASAP report(s). 

(4) The information from sources other than the FAA of an Event Review Committee 
(ERC) investigation concerning an accepted ASAP report. 

(5) Evidence and other information gathered during an ERC investigation by persons 
other than the FAA. 

(6) Statistical analysis and trend information provided by the eligible entity that is based 
on events reported under a particular eligible entity’s ASAP. 

(7) An eligible entity’s database of reports and events collected over time from that 
eligible entity’s ASAP. 

(8) Corrective action on sole-source reports when such corrective action is successfully 
completed. 

Note: In accordance with Section 320 of the FAA Reauthorization Act of 2018, 
Public Law 115-254, ASAP reports that are excluded do not receive protection 
under 49 U.S.C. § 40123. 

c. How Does One Participate? Eligible entities, as described in this amendment, 
participate by executing an ASAP Memorandum of Understanding (MOU) with the FAA and by 
voluntarily sharing information from the ASAP with the FAA. 
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d. What Is the Duration of This Information-Sharing Program? This 
information-sharing program continues for a given eligible entity until the associated ASAP 
MOU is terminated by any of the parties to the MOU. 

8. Findings. The FAA designates information in an accepted ASAP report received from an 
eligible entity under its FAA-approved ASAP program in accordance with this amendment, as 
protected under 49 U.S.C. § 40123 and part 193, § 193.7. The FAA makes this designation based 
on the following findings made under § 193.11(c). 

a. Summary of Why the FAA Finds That the Information Will Be Provided 
Voluntarily. The protection that resulted from Order 8000.82 alleviated concerns of 
ASAP-holding entities that disclosure of voluntarily submitted information could result in its use 
for other than the safety enhancement purposes for which the ASAP was created. Further, under 
ASAP, the FAA takes no action against an individual who submits a report that is accepted (and 
not subsequently excluded). The history of protection under ASAP and the enforcement-related 
incentive encourage voluntary submission of the information. Therefore, the FAA finds that 
eligible entities will voluntarily provide ASAP information to the FAA. Additionally, since the 
implementation of the original part 193 ASAP program, the FAA has seen an increase in the 
sharing of ASAP information with the FAA beyond the FAA ERC representative by those 
originally covered under the program, and expects a similar increase as the program is expanded 
to other entities. 

b. Description of the Type of Information That May Be Voluntarily Provided Under 
the Amended Program and a Summary of Why the FAA Finds That the Information is 
Safety- or Security-Related. 

(1) The FAA expects the eligible entities covered under the designation will share the 
same type of information as entities covered under Order 8000.82. An ASAP is created 
specifically to provide a means for employees to report safety-related events. All individual 
ASAP reports are clearly labeled as such and must be signed by each employee seeking the 
enforcement incentives available under an ASAP. Two types of reports are ordinarily submitted 
under the ASAP: 

• Safety-related reports that appear to involve one or more violations of the 
regulations (e.g., deviating from an Air Traffic Control (ATC)-assigned altitude); 
and 

• Reports that identify a general safety concern, but do not appear to involve a 
violation of the regulations (e.g., flight crewmember concerns that the design of a 
flight checklist could lead to an error). 

(2) Each ASAP report must contain sufficiently detailed information about a safety event 
so that it can be evaluated by a third party. If the report is submitted by a flight crewmember, and 
the safety event involves a deviation from an ATC clearance, the ASAP report would include the 
date, time, place, altitude, flight number, and ATC frequency, along with a description of the 
safety-related event. The only types of reports that are expected to be submitted under an ASAP 
are those that are safety- or security-related. 
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c. Summary of Why the FAA Finds That the Disclosure of the Information Would 
Inhibit Persons From Voluntarily Providing That Type of Information. Eligible entities and 
their employees are reluctant to share sensitive safety information with the FAA, including 
employee self-reports of alleged violations, if such submissions might be subject to public 
disclosure. Among other reasons, entities are concerned that public disclosure of voluntarily 
provided information to the public could be incomplete, unreliable, and sensitive. As a result, 
entities are concerned that disclosure of such information could unduly and adversely affect 
competitive advantage and public perception, and would be used for other than the safety 
enhancement purposes for which the ASAP was created. Individuals are concerned that 
disclosure of their reports would adversely affect their privacy interests. 

d. Summary of Why the Receipt of That Type of Information Aids in Fulfilling the 
FAA’s Safety and Security Responsibilities. The FAA finds that receipt of ASAP information 
aids in fulfilling the FAA’s safety and security responsibilities because of its capacity to provide 
early identification of needed safety improvements. An ASAP offers significant potential for 
incident and accident avoidance. FAA experience has clearly established that an ASAP can 
produce safety-related data that is not available from any other source. For example, ASAP 
reports concerning altitude deviations have identified common causal factors that produce such 
incidents. Receipt of this previously unavailable information has provided the FAA with an 
improved basis for modifying procedures, policies, and regulations in order to improve safety 
and efficiency. 

e. Summary of Why Withholding Such Information From Disclosure Would Be 
Consistent With the FAA’s Safety and Security Responsibilities, Including a Statement as 
to the Circumstances Under Which, and a Summary of Why, Withholding Such 
Information From Disclosure Would Not Be Consistent With the FAA’s Safety and 
Security Responsibilities, as Described in § 193.9. 

(1) Withholding ASAP information from disclosure is consistent with the FAA’s safety 
and security responsibilities because, unless the FAA can provide assurance that it will not be 
disclosed, the FAA will likely not receive the information. If the FAA does not receive the 
information, the FAA will be hampered in efforts to understand safety-related issues within an 
eligible entity’s operational environment and ensure safety improvements that receipt of the 
information otherwise enables. 

(2) The FAA may disclose information submitted to the agency that is designated as 
protected under part 193 when withholding it would not be consistent with the FAA’s safety and 
security responsibilities under the circumstances described in § 193.9(a)(1)–(4). For example, to 
explain the need for changes in FAA policies, procedures, and regulations, the FAA may 
disclose de-identified (i.e., no eligible entity or employee identity), summarized information that 
has been derived from ASAP information or extracted from reports under ASAP. The FAA may 
disclose de-identified, summarized ASAP information that identifies a systemic problem in the 
aviation system when other people need to be advised of the problem in order to take corrective 
action. 
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f. Summary of How the FAA Will Distinguish Information Protected Under Part 193 
From Information the FAA Receives From Other Sources. 

(1) The process for distinguishing information from the eligible entities as protected will 
remain unchanged. All employee ASAP reports are clearly labeled as such. A single report must 
be signed by all employees seeking the enforcement incentives available under an ASAP for the 
event. Any such employee must submit a separate signed report. 

(2) Any other information received by the FAA from the eligible entity concerning the 
content of ASAP reports (such as statistical analyses, program review reports, and trend 
information) must be clearly labeled as follows in order to be protected under this designation: 

WARNING: The information in this document may be protected from 
disclosure under 49 U.S.C. § 40123 and part 193. 

g. Summary of the Significant Comments Received and the FAA’s Responses. On 
September 3, 2003, the FAA issued an order designating information protected. On February 11, 
2022, the FAA issued a Federal Register Notice announcing the FAA intended to amend the 
order. The FAA did not receive any comments in response to that Federal Register Notice. The 
FAA is now issuing this final order amending the September 3, 2003 order to expand the prior 
designation as set forth in the February 11, 2022 Federal Register Notice. 

9. Designation. Accordingly, the FAA hereby designates the previously described information 
to be protected from disclosure in accordance with 49 U.S.C. § 40123 and part 193, when 
submitted pursuant to an approved ASAP program. 

10. Directive Feedback Information. Direct questions or comments to the Air Transportation 
Division (AFS-200) at 202-267-8166. For your convenience, FAA Form 1320-19, Directive 
Feedback Information, is the last page of this order. Note any deficiencies found, clarifications 
needed, or suggested improvements regarding the contents of this order on FAA Form 1320-19. 

Wesley L. Mooty 
Acting Deputy Executive Director, Flight Standards Service 



Directive Feedback Information 

Please submit any written comments or recommendation for improving this directive, or 
suggest new items or subjects to be added to it. Also, if you find an error, please tell us 
about it. 

Subject: FAA Order 8000.82A, Amended Designation of Aviation Safety Action 
Program (ASAP) Information As Protected From Public Disclosure Under 14 CFR    
Part 193

To: Flight Standards Directive Management Officer, AFB-120 Directives Mailbox 
(9-AWA-AFB-120-Directives@faa.gov) 

(Please check all appropriate line items) 

An error (procedural or typographical) has been noted in paragraph  __________  on 
page ____________ . 

Recommend paragraph  _  ___________ on page  _________  be changed as 
follows: (attach separate sheet if necessary) 

In a future change to this order, please cover the following subject: 
(briefly describe what you want added) 

Other comments:

I would like to discuss the above. Please contact me. 

Submitted by: _________________________________  Date: _____________ 

Telephone Number: ___________________ Routing Symbol: _______________ 

FAA Form 1320-19 (10-98) 
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	4. What This Order Cancels. FAA Order XX-XXXX, Title, dated August 8, 1981, is canceled.
	5. Explanation of Policy Changes. Per Order 1320.1E, this optional paragraph is to be used to “highlight briefly significant changes” in a revision. If the POC does not provide this paragraph, add a suggested one based on the ESF text and ask for appr...
	6. Action Date. Optional paragraph used for a one-time action that has a deadline other than the effective date of the order. The date should always be written out as [Month] [xx], [xxxx] (not xx/xx/xx).
	7. Effective Date. Optional paragraph used when something becomes effective at a specific date that is later than the publication date (not needed otherwise). The date should always be written out as [Month] [xx], [xxxx] (not xx/xx/xx).
	8. Other Paragraphs. All of the other optional paragraphs used by the POC follow the mandatory and optional paragraphs above.
	Administrative Paragraphs. Administrative paragraphs are placed at the end of the body of an order, or in an appendix titled Administrative Information. If any of the optional paragraphs is long enough, it could be set off as a separate appendix. Thes...
	9. Distribution. This paragraph is mandatory. If the POC does not provide one, suggest it on the IFF.
	10. Background. Optional paragraph.
	11. Delegation of Authority. Optional paragraph.
	12. Authority to Change This Order. Optional paragraph.
	13. Definitions. Optional paragraph.
	14. Related Publications. Optional paragraph.
	15. Forms and Reports. Optional paragraph.
	16. Directive Feedback Information. Direct questions or comments to the XXX Division at 202-XXX-XXXX. For your convenience, FAA Form 1320-19, Directive Feedback Information, is the last page of this order. Note any deficiencies found, clarifications n...
	Appendix A. Order Formatting
	1. Heading 3 Title. Heading 3 must ALWAYS have a title. You must manually apply bold and Title Case to the title (including the period). Keyboard shortcut: Alt 3
	a. Heading 4 Title. This paragraph must have a title, bold face, title case. You must manually apply boldface for all H4 titles. Keyboard shortcut: Alt 4
	b. Keyboard Shortcuts. All Keyboard shortcuts are built into this template. All Heading level shortcuts are Alt + (heading level number). All bullet shortcuts are Ctrl + (heading level number on the right-hand Num pad). Bullet shortcuts require the Nu...
	(1) Heading 5 Title. This paragraph may have a heading, light face, title case. Make consistent within the subparagraph. Keyboard shortcut: Alt 5
	(a) Heading 6 Title. If this paragraph has a title, it is light face, Title Case. Make consistent within the subparagraph. Keyboard shortcut: Alt 6
	1. Heading 7 Title. If this paragraph has a title, it is light face, Title Case. Make it consistent within the subparagraph. Keyboard shortcut: Alt 7
	a. Heading 8 paragraphs do not have titles. Keyboard shortcut: Alt 8
	i. Heading 9 paragraphs do not have titles. Keyboard shortcut: Alt 9







	2. Stray Paragraph Marks. Do not leave any extra paragraph marks in the document. Paragraph marks carry formatting that can become corrupted and cause problems.
	3. Figures and Tables.
	a. Figures.
	(1) Tag the Figure. Images should be tagged as Normal, centered on the page, and in line with text (right click, choose “size and position,” and click on the “Text Wrapping” tab).
	(2) Provide Alternate Text. Remember to add Web text to describe the image for 508 compliance. Normally, the Web text will be the figure number and title. To set this, right click on the image, choose “Format Picture,” then choose the third icon label...


	Sometimes a “Figure” contains—or is entirely—text, such as a sample letter.
	In this case, tag all paragraphs as H3 and remove the numbering.
	These figures can be formatted however the POC likes, but each paragraph must be tagged. Usually, tagging each paragraph H3 and modifying as desired is effective.
	b. Tables.
	(1) Tag the Table.
	(a) Click and drag over the entire table to highlight all the cells. Click on the Table Tools Design tab at the top of the screen. Mouse over the picture of a plain grid with no shading and only thin lines, and the style name “Table Normal 1” should a...



	(b) Click and drag across the first row of the table to highlight its cells. Right-click inside the row and click on “Table Properties” from the menu that opens. In the “Row” tab, check the box, “Repeat as header row at the top of each page.” This tag...
	(2) Provide Alternate Text. Click and drag over the entire table to highlight all the cells. Right-click inside the table and click on “Table Properties” from the menu that opens. Click on the “Alt Text” tab and type the table’s number and title into ...
	(3) Paragraph Following a Table. When a paragraph follows a figure or table, manually set the before spacing on the paragraph to 12 pts (Paragraph menu, Indents and Spacing tab) so that the text does not abut the table (as this paragraph does).
	4. Headers and Footers. Header and footer text is 12 pt Arial. “Different First Page” should be checked in the header/footer Design tab only in the body of the order. No first/even/odd page distinctions are needed in the appendices.
	a. First Page.
	(1) Header. The first page header only includes “DRAFT” and “(For Internal FAA Coordination Only)” above the masthead. The first page header does not include the date or order project number.
	(2) Footer. The first page footer should appear as follows (fill in the OPR’s routing code). In order to add or remove the bar, click into the footer, then click the border drop-down () in the Home tab, and then open the Borders and Shading menu. Choo...

	b. Remaining Pages.
	(1) Headers. Header tabs are at 3.25” (center) and 6.5” (right). Enter the order’s number on the right side (ONLY the number, without the word “Order”), e.g. “8900.2”).
	(a) For documents going through formal coordination (without simultaneous Public Comment), follow the format below:



	(b) For documents posted for Public Comment, remove “(For Internal FAA Coordination Only)” from the header.
	(c) For all documents post-coordination (at FCP stage) and for all documents that do not receive coordination, remove “DRAFT” and “(For Internal FAA Coordination Only)” from the header.
	(2) Footers. Footers consist of the page number, centered.
	Appendix B. Appendix Formatting (Title Heading 1- Keyboard Shortcut Alt 1, Arial 12 pt bold)
	If your order has no appendices, take the following steps before deleting this appendix to prevent the headers and footers from being corrupted.
	Open the header of the first page of the appendix, and click “Link to Previous” in the Design menu at the top of the screen, and then click “Yes.” Then click into the first page’s footer and do the same. Then do the same for both the header and the fo...
	Appendix content can be formatted however the POC likes, but each paragraph must be tagged. Usually, tagging each paragraph H3 and modifying as desired is effective. If the appendix has a different numbering system than the body of the order, DO NOT m...
	1. Tag all paragraphs first.
	2. Manually type in numbers and add spacing (using tabs and indents on the rule bar) as desired.
	3. If Word switches your numbering to the autonumbering system, use Ctrl Z to undo the action.

	Appendix C. Change Bars
	Change bars are vertical lines in the left margin that show what information has changed since the previous version of the document. A change to an order (e.g., Order 8000.95 CHG 3) will have change bars inserted during initial formatting and retained...
	a. Drawing Change Bars.
	(1) From the Insert tab, click on the Shapes menu, and choose a straight line. Click and drag along the left margin where you want the change bar to appear. Hold down the shift key while drawing the line, which helps to keep it vertical.
	(2) See the style guide for information on when to use change bars.

	b. Properties.
	(1) Format Shape Menu.
	(a) Set the width at 3 pt and the color black (you can right-click and choose “Set as default line” so all future CHG bars have these settings automatically).
	(b) The alt text should appear exactly as follows:

	(2) More Layout Options Menu. See the screenshots below for examples of the following.
	(a) For “Absolute position,” space MOST CHG bars at -.13 to the right of Column (i.e., one eighth of an inch to the left of the left margin).




	(b) As an exception to the above, if a figure or table juts into the left margin, move the CHG bars on that page to the left enough to create some breathing room between them and the figure or table.
	(c) Change bars have anchors to keep them next to the text that they pertain to. The anchor should be positioned at the top of the paragraph where the CHG bar begins, and then locked in the Layout menu. You can move the anchor by clicking and dragging...
	Appendix D. Incorporating Publication Information
	1. Masthead. After the order has received the AFX-1 signature, replace the Effective Date “xx/xx/xx” with the date signed by AFX-1 (e.g., 9/1/16). For new orders, replace the project code in the masthead with the assigned order number (e.g., “8000.ABC...
	2. Headers and Footers. Replace “DATE” in the header with the date signed by AFX-1 (e.g., 11/1/13). For new orders, replace the project code with the assigned order number (e.g., “8000.ABC” becomes “8000.21”).
	3. Properties. For new orders, in the Title field, replace the project code with the order’s publication number (e.g., 8000.ABC becomes 8000.21).
	4. Signature Block. Update the signature block with the name of the signer (if someone else signed for the Executive Director).
	a. Autopen Copy. In the Autopen copy, retag the signature block to remove the automatic spacing and add four returns above it to make room for the autopen signature. See sample below.

	X. Directive Feedback Information. Direct questions or comments to the XXX Division at 202-XXX-XXXX. For your convenience, FAA Form 1320-19, Directive Feedback Information, is the last page of this order. Note any deficiencies found, clarifications ne...
	b. Pub Copy and RGL Copy. In the Pub copy and RGL copy, retag the signature block to remove the extra space above, add “ORIGINAL SIGNED by” on a line above it, and tag that new line “ORIGINAL SIGNED by” (Keyboard shortcut: Alt O) to set the correct sp...


	X. Directive Feedback Information. Direct questions or comments to the XXX Division at 202-XXX-XXXX. For your convenience, FAA Form 1320-19, Directive Feedback Information, is the last page of this order. Note any deficiencies found, clarifications ne...
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